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Cisco Unified Presence のインストール準備

• 「Cisco Unified Presence インストールの前提条件について」（P.1）

• 「VMware Server に Cisco Unified Presence をインストールする際の前提条件について」（P.5）

• 「インストール前タスクの実行」（P.8）

• 「参考情報の入手」（P.9）

Cisco Unified Presence インストールの前提条件について
ここでは、Cisco Unified Presence のインストールに関して最もよく寄せられる質問について説明し、

ネットワークに Cisco Unified Presence をインストールする前に確認が必要な情報を示します。円滑に

設定するには「準備チェックリスト」を使用して、インストール前に必要な情報をすべて収集してくだ

さい。

関連項目

付録 A「インストール準備チェックリスト」

• 「必要なパスワード」（P.2）

• 「サポートされるサーバ」（P.3）

• 「ブリッジのアップグレード」（P.4）

• 「サポートされるブラウザ」（P.4）

• 「ソフトウェアの制限事項」（P.4）
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第 1 章      Cisco Unified Presence のインストール準備

    Cisco Unified Presence インストールの前提条件について
必要なパスワード

Cisco Unified Presence のインストール中に、次のユーザ名とパスワードを指定する必要があります。

パスワードの種類 説明 トラブルシューティングのヒント

管理者アカウント 次のインターフェイスにログインするに

は、管理者のユーザ ID とパスワードを

作成する必要があります。

• Cisco Unified Operating System の
管理インターフェイス

• Disaster Recovery System の管理イ

ンターフェイス

• コマンドライン インターフェイス

（CLI）

• 管理者ログインは、先頭がアル

ファベットで 6 文字以上必要で

す。英数字、ハイフン、および

アンダースコアを使用できます。

• 管理者のパスワードを紛失して

システムにアクセスできない場

合は、Cisco Unified 
Communications Operating 
System の管理ページで、管理

者パスワードを復旧できます。

• 管理者パスワードのリセットが

必要な場合は、CLI を使用しま

す。必要な CLI の構文について

は、このガイドの付録にある

「インストール準備チェックリ

スト」を参照してください。
1-2



 

第 1 章      Cisco Unified Presence のインストール準備

    Cisco Unified Presence インストールの前提条件について
サポートされるサーバ

Cisco Unified Presence をインストールする前に、次の手順に従ってください。

• 使用するハードウェアを確認し、サーバがサポートされていることを確認する必要があります。

Cisco Unified Presence のリリースをサポートしているサーバについては、次の URL にある

『Hardware and Software Compatibility Information for Cisco Unified Presence』を参照してください。

http://www.cisco.com/en/US/products/ps6837/products_device_support_tables_list.html

• ネットワークで Cisco Unified Presence マルチノード機能を設定する場合は、次の URL にある

『Deployment Guide for Cisco Unified Presence』のマルチノード ハードウェアの推奨事項、および

インストールとアップグレード情報を参照してください。

http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list
.html

アプリケーション 
ユーザ アカウント

Cisco Unified Presence の管理インター

フェイスにログインするには、アプリ

ケーション ユーザ ID とパスワードを作
成する必要があります。

アプリケーション ユーザ パスワー

ドのリセットが必要な場合は、CLI 
を使用します。必要な CLI の構文に

ついては、このガイドの付録にある

「インストール準備チェックリスト」

を参照してください。

セキュリティ パス

ワード

インストールする 
Cisco Unified Presence サーバ用に、
Cisco Unified Communications Manager 
からセキュリティ パスワードを取得す
る必要があります。

Cisco Unified Presence に設定するセ

キュリティ パスワードは、Cisco 
Unified Communications Manager 
Publisher サーバで使用されるパスワー

ドと同一にする必要があります。

• Cisco Unified Communications 
Manager のセキュリティ パス

ワードを紛失した場合は、
Cisco Unified Communications 
Manager サーバでパスワードを

確認できません。

• インストール後の導入ウィザー

ドで、Cisco Unified 
Communications Manager セ
キュリティ パスワードをリセッ

トできます。このウィザード

は、Cisco Unified Presence の
管理機能に初めてログインした

ときに表示されます。

• Cisco Unified Presence の管理

ページに初めてログインした後
に Cisco Unified 
Communications Manager セ
キュリティ パスワードをリセッ

トするには、

Cisco Unified Presence の管理

ページで [システム（System）] 
> [CUCM パブリッシャ

（CUCM Publisher）] の順に選

択します。

パスワードの種類 説明 トラブルシューティングのヒント
1-3
Cisco Unified Presence Release 8.0 インストレーション /アップグレード ガイド

http://www.cisco.com/en/US/products/ps6837/products_device_support_tables_list.html
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.html
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.html


第 1 章      Cisco Unified Presence のインストール準備

    Cisco Unified Presence インストールの前提条件について
ブリッジのアップグレード

Cisco Unified Presence Release 8.0 では次のハードウェアがサポートされません。

• MCS-7825-H1-IPC1

• MCS-7825-I1-IPC1 

• MCS-7835-H1-IPC1 

• MCS-7835-I1-IPC1 

• MCS-7845-H1-IPC1 

• MCS-7845-I1-IPC1

Cisco Unified Presence には、ここにリストされている製造中止となったハードウェアからサポート対

象のハードウェアへの移行を希望するお客様に、ブリッジ アップグレードが用意されています。ブ

リッジ アップグレードにより、製造中止となったハードウェアに DRS バックアップを作成できるよう

になります。Cisco Unified Presence をサポート対象ハードウェアに新規インストールした後で、この 
DRS バックアップをサポート対象ハードウェアに復元できます。

ここにリストされている製造中止となったハードウェアでアップグレードしようとすると、

Cisco Unified Presence はインターフェイスと CLI に警告を表示します。また、

Cisco Unified Presence では、サーバでの DRS バックアップの作成機能だけがサポートされているこ

とが通知されます。

関連項目

• 『Disaster Recovery System Administration Guide』

サポートされるブラウザ

Cisco Unified Presence の管理ページ、Cisco Unified Serviceability、および Cisco Unified 
Communications Operating System の管理ページの各インターフェイスにアクセスするには、

Microsoft Internet Explorer バージョン 6.0 以降あるいは Mozilla Firefox バージョン 3.0 以降を使用す

る必要があります。

ソフトウェアの制限事項

Cisco Unified Presence は、シスコシステムズが承認したソフトウェアだけをアップロードおよび処理で

きます。サードパーティの Linux または Windows ベースのソフトウェア アプリケーションを、Cisco 
Unified Presence にインストールしたり使用することはできません。Cisco Unified Operating System の管

理ページで、有効なソフトウェアのインストールおよびアップグレードを実行してください。
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第 1 章      Cisco Unified Presence のインストール準備

    VMware Server に Cisco Unified Presence をインストールする際の前提条件について
VMware Server に Cisco Unified Presence をインストー
ルする際の前提条件について

• 「VMware のソフトウェア要件」（P.5）

• 「VMware のハードウェア要件」（P.5）

• 「サポートされる VMware の設定」（P.5）

• 「VMware 機能のサポート」（P.6）

• 「VMware のライセンス要件」（P.6）

• 「VMware インストールの例外事項」（P.7）

• 「Cisco UCS B シリーズ ブレード サーバへの移行」（P.7）

• 「OVF テンプレートのインポート」（P.8）

VMware のソフトウェア要件

VMware のソフトウェア要件は次のとおりです。

• Cisco Unified Presence Release 8.0 

• VMware ESXi Release 4.0

（注） VMware 上で Cisco Unified Presence を実行するには、ESX ではなく ESXi を使用するようにしてくだ

さい。ただし、ブレード サーバは VMware ESX クラスタの一部にすることができます。

「サポートされる VMware の設定」（P.5） に記載されているサポート対象の VMware 仕様のいずれかを

使用すると、Cisco Unified Presence Release 7.0(5) 以降から Cisco Unified Presence Release 8.0 に 
VMware 上でアップグレードできます。

VMware のハードウェア要件

Cisco Unified Presence は、Cisco UCS B シリーズ ブレード サーバだけで VMware をサポートします。

Media Convergence Server（MCS）から Cisco UCS B シリーズ ブレード サーバでの VMware 上への 
Cisco Unified Presence の移行に関する詳細については、「Cisco UCS B シリーズ ブレード サーバへの

移行」（P.7） を参照してください。

サポートされる VMware の設定

表 1-1 に、VMware サーバ上の Cisco Unified Presence の推奨（最小）仕様を示します。

表 1-1 VMware の推奨仕様

ユーザ vCPU RAM vDisk

仕様 1： 2500 2 4 GB 1 x 80GB

仕様 2： 5000 4 4 GB 2 x 80GB
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第 1 章      Cisco Unified Presence のインストール準備

    VMware Server に Cisco Unified Presence をインストールする際の前提条件について
事前設定された仮想マシンをインポートする場合、シスコでは、事前定義された CPU 情報、ディスク

情報および RAM 情報が含まれる VM 仕様ごとに、OVM テンプレートを提供しています。OVF テン

プレートは Cisco.com からダウンロードする必要があります。Cisco.com の OVF テンプレートの場所

については、『Release Notes for Cisco Unified Presence』を参照してください。

Cisco Unified Presence は、インストール中に、ハードウェア チェックを実行します。このチェックで

は、サポートされる VMware サーバ プラットフォーム タイプを使用しているかどうかと、VMware 
サーバが最小仕様を満たしているかどうかが確認されます。サポートされる VMware 設定を実行して

いない場合、Cisco Unified Presence は、サポート対象の設定ではないことと、この設定を実働環境で

は使用できず、ライセンスも受けられないことを示す警告を表示します。

関連項目

• 『Release Notes for Cisco Unified Presence』

• 「OVF テンプレートのインポート」（P.8）

VMware 機能のサポート

表 1-2 に、Cisco Unified Presence の VMware 機能サポートを示します。

VMware のライセンス要件

VMware サーバで実行される Cisco Unified Presence のライセンスを取得するには、サーバのライセン

ス MAC 値が必要です。[Cisco Unified OS の管理（Cisco Unified OS Administration）] > [表示

（Show）] > [システム（System）] の順に選択するか、[表示（Show）] > [ネットワーク（Network）] 
の順に選択して、ライセンス MAC 値を表示します。

表 1-2 VMware 機能のサポート

VMware 機能 サポートの有無

VMotion なし

（注） Cisco は VM の終了と、その後の別のブレード 
サーバ でのリブートをサポートします。ブレード 
サーバをメンテナンス モードに設定する場合、こ

れが役立つことがあります。

SVmotion なし

スナップショット なし

Data Recovery Manager なし

Fault Tolerance なし

Consolidated Backup なし

ハイ アベイラビリティ あり

Site Recovery Manager あり

（注） このパラメータに関連付けられたすべてのサーバ

は、同じサーバ エリア ネットワーク（SAN）に配

置されている必要があります。
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第 1 章      Cisco Unified Presence のインストール準備

    VMware Server に Cisco Unified Presence をインストールする際の前提条件について
Cisco Unified Presence ライセンスの取得方法の詳細については、『Deployment Guide for 
Cisco Unified Presence』を参照してください。

Cisco Unified Presence 8.0 でサポートされるハードウェアへのブリッジ アップグレードを実行するに

は、VMware の新規ライセンス MAC 値で、新規サーバおよびソフトウェア バージョン のライセンス 
ファイルを要求する必要があります。これを実行するには、ご使用のライセンスの「rehost」を要請す

る電子メールを licensing@cisco.com まで送信してください。この手順の詳細については、

『Deployment Guide for Cisco Unified Presence』を参照してください。

関連項目

• 「ブリッジのアップグレード」（P.4）

• 『Deployment Guide for Cisco Unified Presence』

VMware インストールの例外事項

Cisco Unified Presence を VMware 仮想マシンにインストールする場合は、Cisco Unified Presence を
物理サーバにインストールする場合と同じ手順に従ってください。ただし、次の例外事項があります。

• インストールに失敗すると、Cisco Unified Presence のインストール ログが VMware サーバのシ

リアル ポートを介してファイルにダンプされます。Cisco Unified Presence のインストール ログは 
USB キーへはダンプできません。シリアル ポートを VMware サーバに設定する必要があります。

具体的には、Cisco Unified Presence が ASCII テキストをダンプできるファイルにシリアル ポー

トをリンクする必要があります。VMware サーバの電源がオフのときに、シリアル ポートを設定

する必要があります。そのため、VMware サーバでこの設定を実施した後で、インストールを開始

するようにしてください。

• Cisco Unified Presence は、VMware サーバでの USB テープ ドライブへのバックアップをサポー

トしません。

Cisco UCS B シリーズ ブレード サーバへの移行

Cisco Unified Presence は、Cisco UCS B シリーズ ブレード サーバ上の VMware をサポートしていま

す。Media Convergence Server（MCS）から Cisco UCS B シリーズ ブレード サーバ上の 
Cisco Unified Presence VMware に移行する場合、次の（高度な）手順を実行してください。

1. Cisco Unified Operating System インターフェイスを使用して、MCS サーバを 
Cisco Unified Presence Release 8.x にアップグレードします。このリリースに関係する特定のアッ

プグレード情報については、リリース ノートを参照してください。

2. MCS サーバで DRS バックアップを実行します。Cisco Unified Presence は、VMware サーバでの 
USB テープ ドライブへのバックアップをサポートしません。

3. OVF テンプレートをインポートして、UCS サーバに仮想マシンを作成します。

4. MCS サーバの電源を切ります。

5. Cisco Unified Presence Release 8.x を仮想マシンにインストールし、DRS の復元を実行して、

MCS サーバからバックアップされたデータをCisco Unified Presence UCS サーバ上の VMware に
復元します。Cisco Unified Presence は、VMware サーバでの USB テープ ドライブの復元をサ

ポートしません。

6. ライセンスの MAC 値を取得し、次に VMware サーバ用に新しいライセンスを要求します。

7. 新しいライセンスをサーバにアップロードします。

8. 無効となった元のライセンス ファイルを手動で削除し、ライセンス マネージャを再起動します。
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第 1 章      Cisco Unified Presence のインストール準備

    インストール前タスクの実行
関連項目

• 『Release Notes for Cisco Unified Presence』

• 『Cisco Unified Operating System Maintenance Guide for Cisco Unified Presence』

• 『Changing the IP Address and Hostname for Cisco Unified Presence』

• 『Disaster Recovery System Administration Guide』

• 「OVF テンプレートのインポート」（P.8）

OVF テンプレートのインポート

開始する前に

Cisco.com での OVF テンプレートの場所のリンクを取得する方法については、『Release Notes for 
Cisco Unified Presence』を参照してください。

手順

ステップ 1 Cisco.com から CUP 2500 user v1 vmv7.ova などの OVF テンプレートをダウンロードします。

ステップ 2 同じコンピュータで vSphere クライアントを実行します。

ステップ 3 [Hosts and Clusters] ウィンドウで、[File] > [Deploy OVF Template] の順に選択します。

ステップ 4 [Deploy from file] を選択します。

ステップ 5 CUP_2500_user_v1.0_vmv7.ova などの以前ダウンロードした OVF テンプレートを参照して選択します。

ステップ 6 [Next] を選択します。

ステップ 7 新たに作成された仮想マシンを右クリックして [Edit Settings] を選択します。

ステップ 8 [Options] > [Boot Options] を選択します。

ステップ 9 [Force BIOS Setup] をオンにします。

ステップ 10 仮想マシンの電源をオンにします。

ステップ 11 [Boot] メニューを選択し、CD-ROM ドライブが最初のドライブとして選択されていることを確認しま

す。F10 を押して起動の順序保存します。

関連項目

• 『Release Notes for Cisco Unified Presence』

• 「サポートされる VMware の設定」（P.5）

インストール前タスクの実行

開始する前に

このガイドの付録を参照してください。付録には、インストール前に収集する情報を記載した準備

チェックリストや、各データ タイプをインストール後に変更可能かどうかの情報があります。この

チェックリストを印刷して設定データを記入し、インストール中に参照することを推奨します。
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第 1 章      Cisco Unified Presence のインストール準備

    参考情報の入手
関連項目

• 付録 A 「インストール準備チェックリスト」

• 「ブリッジのアップグレード」（P.4）

• 『Deployment Guide for Cisco Unified Presence』

参考情報の入手 
インストールのプロセスと前提条件についてよく理解するため、このマニュアルの内容すべてに目を通

すことを強く推奨します。さらなる詳細については、次のCisco Unified Presence に関するガイドを参

照してください。

• Cisco Unified Presence の管理ページのオンライン ヘルプ

Cisco Unified Presence の設定、保守、および管理方法を順を追って説明します。

• 『Hardware and Software Compatibility Information for Cisco Unified Presence』

インストール前のタスク 特記事項

ステップ 1 Cisco Unified Presence サーバが Cisco Unified 
Communications Manager パブリッシャ サーバにネット

ワーク アクセスできることを確認します。

Cisco Unified Communications Manager に、他のサー

バから ping を実行します。

ステップ 2 対応する Cisco Unified Communications Manager サーバ

で Cisco AXL Web Service が起動していることを確認し

ます。

Cisco Unified Serviceability で [Tools] > [Service 
Activation] の順に選択します。

ステップ 3 DNS を使用する場合は、DNS サーバで新しい 
Cisco Unified Presence サーバのホスト名を設定したこ

とを確認します。また、DNS サーバが、Cisco Unified 
Communications Manager パブリッシャ サーバのホスト

名、および他のCisco Unified Presence サーバ（存在す

る場合）のホスト名を解決できることを確認します。

注意 Cisco Unified Presence と Cisco Unified 
Communications Manager で同じ DNS サー

バを使用することを推奨します。異なる 
DNS サーバを使用すると、システムの動作

に異常が発生する場合があります。

Cisco Unified Presence でマルチノード機能

を使用する場合は、DNS 設定オプションに

ついて『Deployment Guide』を参照してくだ

さい。

ステップ 4 Cisco Unified Presence 新規インストール後に、システ

ムはデフォルトで 90 日間の評価モードになります。

Cisco Unified Presence を実稼動モード（試行版の評価

期間の終了前または終了後）に移行できるようにするに

は、まず Cisco Unified Presence の新規インストールに

ついて正しいサーバ ライセンスを取得する必要がありま

す。サーバ ライセンスは、Cisco Unified Presence サー

バをサポートし、Presence Engine およびプロキシ サー

ビスのサービス アクティベーションを可能にします。

Cisco.com の License Generation Web ツールを使用す

ると、必要な単位数のライセンス ファイルを生成でき

ます。

Cisco Unified Presence ライセンス要件とライセンス取

得の詳細については、『Deployment Guide for Cisco 
Unified Presence』を参照してください。

ステップ 5 Cisco Unified Presence Release 8.0 へのアップグレード

を実行するには、ソフトウェア バージョン（アップグ

レード）ライセンスを取得してください。

これは、Cisco Unified Presence Release 8.0 へのブリッ

ジ アップグレードを実行する場合にも当てはまります。

Cisco Unified Presence ライセンス要件とライセンス取

得の詳細については、『Deployment Guide for Cisco 
Unified Presence』を参照してください。
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第 1 章      Cisco Unified Presence のインストール準備

    参考情報の入手
現在使用している Cisco Unified Presence と互換性のあるハードウェア サーバおよびソフトウェア

について説明しています。

• 『Port Usage Information for Cisco Unified Presence』

Cisco Unified Presence リリースのポート情報について説明しています。

• 『Changing the IP Address and Hostname for Cisco Unified Presence』 

Cisco Unified Presence サーバの IP アドレスまたはホスト名の変更手順について説明しています。

• 『Cisco Unified Operating System Maintenance Guide for Cisco Unified Presence』

ソフトウェアのアップグレード情報、およびオペレーティング システムやコマンドライン イン

ターフェイスを介して利用できるユーティリティについて説明しています。

• 『Deployment Guide for Cisco Unified Presence』

Cisco Unified Presence および Cisco Unified Communications Manager の設定手順の概要について

説明しています。また、Cisco Unified Presence と Microsoft Live Communications Server、
Microsoft Active Directory、および Microsoft Office Communicator との統合に関する情報を記載

しています。また、マルチノードでの導入に対応した戦略、および高可用性のためのシスコの推奨

事項も含まれています。

• 『Serviceability Configuration and Maintenance Guide for Cisco Unified Presence』

Cisco Unified Presence のサービスアビリティについて説明しています。アラーム設定、トレース

設定、およびその他のレポートについても順を追って説明しています。

• 『Disaster Recovery System Administration Guide』

バックアップの設定方法、Cisco Unified Presence データのバックアップ方法、およびデータの復

元方法について説明しています。

• Cisco Unified Communications Manager の詳細については、次の URL を参照してください。
http://cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html?q=
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